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Complete Amplifier Evaluation System
• TXS25-4: 4-Channel Digital Amplifier 

• Single Power Supply (+25V) Operation

• Internally Generated Negative Rail High-voltage Supply 
(-25V)

• Internally Generated and Regulated Low-voltage Supplies 
(+5V/+3.3V/1.8V) 

• D2Audio Canvas II™ Installation CD-ROM (includes USB 
Driver and D2Audio Canvas II User’s Guide)

• Detachable Digital/Analog Audio/Control I/O and Power 
Assembly Boards

• “SCAMP III” Header Pins on Digital/Analog Audio/Control 
I/O Board Enables In-system Firmware Upgradeability 

• Optical (TOSLINK) and Coax Digital S/PDIF Inputs that 
Accept an IEC60958 Compliant Interconnect Carrying 
Linear PCM with an Fs of 32kHz~192kHz

• Optical (TOSLINK) Digital S/PDIF Output

• 4 Channels of Analog Audio Inputs Using 
High-Performance 4-Channel Analog-to-Digital Converter 
(ADC)

• 2 I2S/Left-Justified Digital Audio Input Headers

• 2 I2S/Left-Justified Digital Audio Output Headers

• Rotary Knob Connected to GPIO Lines Enables Simple 
Master Volume Control for Channels 1 and 2

• Subwoofer Analog Audio Output (Passive Filtered PWM 
Line Level Output)

• High-Quality Speaker Banana-Jack Connectors

D2Audio Canvas II™GUI Simplifies System Design
• Intuitive, “Point-and-click” Audio-Centric User Interface 

Simplifies Evaluation of All Audio Processing 
Configurations

• Configuration for Stereo, Dual Zone, Stereo Bi-Amp or 
Powered 2.1 Systems Takes Less than a Minute

Selectable DSP Processing Functions
• Input Selection (Analog, S/PDIF, I2S/Left-Justified)

• 4 Independent Channels of Audio Processing
- Tone Control
- Matrix Mixing
- Programmable Crossover with Butterworth,

Linkwitz/Riley, Bessel Filter Types
- 5-Band and 3-Band Parametric EQ
- Master Volume Control
- Loudness Contour
- Individual Channel Time Delay
- Per Channel Dynamic Range Compression/Limiting
- Independent Channel Level Controls - Enables 

Independent Level Control for Amplified Channels 1, 2, 
3 and 4 Outputs as well as Digital Audio Outputs

D2Audio SoundSuite™ Immersive Processing
• Mono2Stereo™

• WideSound™

• DeepBass™

• AudioAlign™

The TXS25-4 Evaluation Kit is a complete amplifier 
evaluation system for the TXS25-4 digital amplifier module. 
Audio system designers can quickly evaluate all of the 
features and functions of the TXS25-4 design with this 
system.

This system offers the ultimate in configurations, 
digital/analog I/O and power supply connection. It offers 
headers for all digital audio inputs and outputs so that the 
system designer can quickly and easily “wire-wrap” into the 
board. This enables any I2S/Left-Justified digital audio 
source to be delivered from any digital audio source such as 
an HDMI™ receiver or a Media Networking Processor and 
input into the TXS25-4 amplifier with minimum effort. A 
header is also offered for the control communication bus 
(2-wire interface), which enables fast connection of a system 
microcontroller for rapid prototyping.

The D2Audio Canvas GUI software simplifies system design 
with an intuitive, audio-centric user interface with 
“point-and-click” options on a Windows™ PC. Organized 
processing blocks are included for audio input selection, 
Tone Control, Crossovers, Parametric Equalizers, Adjustable 
Time Delay, Signal Limiter/Compressor, Volume Control, 
Loudness Contour, and Independent Level Control.
CAUTION: These devices are sensitive to electrostatic discharge; follow proper IC Handling Procedures.
1-888-INTERSIL or 1-888-468-3774 | Intersil (and design) is a registered trademark of Intersil Americas Inc.

Copyright Intersil Americas Inc. 2009. All Rights Reserved
All other trademarks mentioned are the property of their respective owners.
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TXS25-4 Evaluation Kit
• Complete Evaluation Platform for TXS25-4

• 4 Channels of Amplified Speaker Outputs

• 4 Channels of Analog Inputs

• 4 Channels of Digital Audio Inputs
(1 S/PDIF and 2 x I2S/Left-Justified Inputs)

• 4 Channels of Digital Audio Inputs (1 S/PDIF and 
2 x I2S/Left-Justified Outputs)

• All necessary voltages are generated from single +25V 
power source reducing cost and complexity of the system 
power supply

• Internally Regulated Low-voltage supplies 
(+5V/+3.3V/1.8V)

• Master Volume Knob (Channels 1 and 2)
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Getting Started

Overview
The TXS25-4 Amplifier evaluation kit consists of 3 boards. 
These boards, shown in Figure 1, consist of the main 
amplifier board, an input board, and an output board. Each 
of these 3 boards are shown in detail in Figures 2, 3, and 4. 
Ribbon cables (supplied) interconnect the 3 boards.

The system can be configured either through software (refer 
also to D2Audio Canvas II Software Configuration 
Documentation found on the D2Audio Canvas II Software 
CD) or configured by hardware settings (see “Input Source 
Options” on page 17).

Platform Configurations
The TXS25-4 Amplifier kit may be configured as a stereo 
amplifier with a single or multiple inputs, and is also capable 
of providing a summed and low-pass filtered output which 
can then be sent to an external powered subwoofer. The 
flexible signal processing flow and extensive digital audio 
inputs and outputs of the TXS25-4 also allows for processed 
output to be connected (as on this evaluation platform) to an 
external DAC to enable post-processed Line-Level Outputs 
or Headphone Outputs.

WARNING
This symbol is used to warn operators that uninsulated “dangerous voltages” 
are present within this equipment that may impose risk of electrical shock

FIGURE 1. TSX25-4 AMPLIFIER BOARDS 
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FIGURE 2. DIGITAL/ANALOG AUDIO/CONTROL I/O BOARD - TOP VIEW 
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FIGURE 3. TXS25-4 AMPLIFIER BOARD - TOP VIEW
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FIGURE 4. AMPLIFIER OUTPUT BOARD - TOP VIEW
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Connection Diagram
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FIGURE 5. TXS25-4 AMPLIFIER PLATFORM CONNECTION AND JUMPER DIAGRAM
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Required Power Source
The TXS25-4 Amplifier requires external operating power of 
a single DC power supply of 12V (minimum) up to 25V 
(maximum), with a minimum current sourcing capability of 
5A. Maximum amplifier output power requires 25V, and 
maximum output power will be reduced as the DC supply 
voltage is also reduced. A well-filtered and regulated power 
supply is recommended. Supply voltage filtering, as well as 
input surge current limiting is provided on the amplifier 
output board where the power supply is connected. However 
amplifier noise performance may be impaired from power 
sources with excessive output ripple.

Quick Start
1. Set up in an ESD-approved work area.
2. Power supply must be OFF and power cord disconnected 

from AC outlet.
3. Observing correct polarity, connect DC output from a 25V, 

5A power supply to connector J28 of the amplifier output 
board (Refer to “ Required Power Source”  for J28 
location and polarity.)

4. Ensure the supplied interconnect ribbon cables are 
connected between J4 of the Input Board and J2 of the 
TXS25-4 Amplifier board, and also between J3 of the 
TXS25-4 Amplifier Board and J27 of the Amplifier Output 
Board.

5. Select input source
- Analog Audio Input . . . . . . . . . . . . . . . . . . . . . . Figure 8
- Optical S/PDIF  . . . . . . . . . . . . . . . . . . . . . . . . . Figure 9
- Coax S/PDIF . . . . . . . . . . . . . . . . . . . . . . . . . . Figure 10

6. Connect Speakers
- Output Device Connection (Stereo) . . . . . . . . Figure 12
- Output Device Connection (Channel System) Figure 13

7. Turn system on by switching on the DC power supply.
8. Play audio source. Adjust master volume for Channels 1 

and 2 using the master volume knob. 

Speaker Channel Pair Matching and Drive 
Requirements
Each of the TXS25-4 output channels are half-bridge, thus a 
load of equal size and content MUST be placed on 
corresponding channel pairs (e.g. Channel 1 and 2, 
Channel 3 and 4). This means that TXS25-4 is not meant to 
drive a 16Ω speaker on Channel 1 with an 8Ω speaker on 
Channel 2. This also means that if Channel 1 is high-pass 
filtered and connected to a tweeter, then Channel 2 must 
also be high-pass filtered and connected to a tweeter.

Speaker Output Phase Relationship Requirements
All TXS25-4 outputs are ground referenced. Channels 2 and 
4 are driven intentionally out of phase with Channels 1 and 
3. The audio heard on all 4-Channels will actually be 
in-phase, as Channels 2 and 4 are inverted inside the 
D2-814xx firmware. Please refer to Figure 5 for connection 
diagram. Speaker loads should also be connected or 
disconnected only when the power to the evaluation kit is 
turned off.

The user need only follow the standard connection method 
of RED terminal to the + lead and the BLACK terminal to the 
- lead of the speaker, as all of these inversions are already 
compensated within both the firmware and in the PCB trace 
connections. 
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Required Speaker
ConnectionsTXS25-4 Amplifier Module

Channel 1
+
-

+
-

Channel 3

-
+ Channel 4

Channel 2
-
+

Note: Channels 2, 4 are 180 degrees out of phase vs. Channels 1, 3.
The above speaker connections are necessary to have all channels in phase.

Speaker Out 1+: J3/1

Speaker Out 3+: J3/9

Speaker Out 2-: J3/4

Speaker Out 4-: J3/12

FIGURE 6. REQUIRED LOUDSPEAKER CONNECTIONS
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FIGURE 11. STEP 6: OUTPUT DEVICE CONNECTION FOR A STEREO/BI-AMP SYSTEM
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Input Source Options
The TXS25-4 amplifier design contains 4 audio input 
channels. Several audio input source connections are 
available on the evaluation kit for these inputs.

Selecting an Audio Input Type (S/PDIF, I2S/LJ or 
Analog)
The default (which includes after a reset or power cycle) 
settings for the TXS25-4 firmware select the S/PDIF input. 
The selection of the audio input can only be changed using 
the Input Select Window inside the D2Audio Canvas II user 
interface GUI.

Selecting Between I2S/Left-Justified Header Input 
and Analog Input
In order to use the Analog Inputs, the user must select the 
“I2S” input. Additionally they must make sure that J18 is 
jumpered. By jumpering both the top and bottom J18 
jumpers, both I2S streams from the 4 Channel ADC are sent 
to both the SAI0 input (labeled I2S0 on the board) and the 
SAI1 input (labeled I2S1 on the board). In order to use the 
I2S/Left-Justified input headers for both SAI0 and SAI1 
input, the user must select the same “I2S” input in the 
D2Audio Canvas II menu in addition to making sure that J18 
is NOT jumpered. Figure 14 shows how the board needs to 
be configured to route both I2S streams from the 4-Channel 
ADC to both the SAI0 input (labeled I2S0 on the board) and 
the SAI1 input (labeled I2S1 on the board). If the user wants 
to send I2S or Left-Justified data into the SAI0 or SAI1 input 
ports, they are free to “wire-wrap” into the input headers 
located at J5 and J8. If they choose to do this, they must 
remove both jumpers from J18. 

Selecting Between Coaxial and Optical S/PDIF 
Input
J19 can be jumpered between Coax and Opt during 
operation with out a need for a board reset in order to select 
Coaxial or Optical S/PDIF input. Figure 15 shows how to 

select the Optical S/PDIF input. The user must still select the 
S/PDIF input mode.

When the S/PDIF input mode is selected (SPDIFRX), the 
COAX/OPT jumper (J19) determines which S/PDIF interface 
will be used. 

Default Configuration
Table 3 highlights the SPDIF I/O board jumper configuration 
for the default factory setting for the TXS25-4 evaluation 
platform. NOTE: The jumpers are stored on the ground pins 
for this configuration. If N/A is listed in the Default Jumper 
Setting column then a jumper is not provided nor should the 
associated header ever be shorted.

TABLE 1. EVALUATION KIT SOURCE OPTIONS

INPUT 
CHANNEL 

AVAILABLE DIGITAL 
SOURCE 

CONNECTIONS ON 
EVALUATION KIT

AVAILABLE ANALOG 
SOURCE 

CONNECTIONS ON 
EVALUATION KIT

Channels 1 thru 4 Coax S/PDIF receiver
Optical S/PDIF 
receiver 
I2S/Left-Justified input 
headers

Direct connection to 4 
Channel ADC, which is 
connected to the 
I2S/Left-Justified

EN ADC TO I2S0
J18

EN ADC TO I2S1

FIGURE 14. ROUTING I2S DATA FROM THE 4-CHANNEL ADC 
TO THE SAI0 AND SAI1 INPUTS

TABLE 2. J13 - S/PDIF INPUT SELECTION OPTIONS

S/PDIF INPUT 
SELECTION COAX OPT

COAX/OPT When S/PDIF input 
mode is enabled the 
Coax S/PDIF connector 
is selected

When S/PDIF input 
mode is enabled the 
Optical S/PDIF 
connector is selected

NOTE: These jumpers are not only read at power-up and after a 
reset to the amplifier design, but also during run time. Changes to the 
jumpers at any time will cause the settings to have an immediate 
effect and do not require a reset of the amplifier design to take effect.

FIGURE 15. SELECTING BETWEEN COAXIAL AND OPTICAL 
S/PDIF INPUT
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.

Master Volume Control
Each time the board is reset or powered up, the master 
volume will revert back to the default setting as stored in the 
EEPROM within the amplifier design. These settings can be 
saved to different levels by using D2Audio Canvas II 
software with the “Save Settings to EEPROM” command. 
When shipped from the factory, these value are -20dB. While 
the board is powered up, the master volume for only 
Channels 1 and 2 may be adjusted by turning the Master 
Volume Control knob located on the input board. Adjusting 
the Master Volume knob will adjust the Master Volume slider 
inside the D2Audio Canvas II GUI, provided that polling has 
been enabled within the D2Audio Canvas II program.

TABLE 3. DEFAULT DIGITAL/ANALOG AUDIO/CONTROL I/O BOARD FACTORY JUMPER SELECTION

JUMPER NUMBER DESCRIPTION
DEFAULT JUMPER 

SETTING
ADDITIONAL

INFORMATION

MCI Header N/A 2-Wire Communication Header

J7 I2S/Left-Justified Output 
Header

N/A Serial Audio Output 0, Serial Audio Output 1, associated LRCLKT, 
SCLKT, MCLKT. Connected to on board DAC

J5 I2S/Left-Justified Input Header N/A Serial Audio Input 0 (SAI0)

J8 I2S/Left-Justified Input Header N/A Serial Audio Input 1 (SAI1)

J6 Control Header N/A Refer to TXS25-4 Data Sheet for more information.

J19 SPDIF Input Select Header Jumper pins 1 to 2 S/PDIF (SPDIFRX) Coax Input selected

1357911131517192123252729

24681012141618202224262830
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FIGURE 16. MASTER VOLUME CONTROL KNOB
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Optional I2S/Left-Justified Connection
The TXS25-4 evaluation board may be connected to 
external I2S (or Left-Justified) audio sources. Three pins on 
jumpers J8 and J5 are available for I2S (or Left-Justified) 
connections (see Tables 4 and 5). The user must remove 
both jumpers on J18 in order to avoid clock and data 
contention from that being sent by the 4 channel ADC. The 
interface is a 3.3V signaling level with the I2S data format 
selected. Sample rates from 32kHz up to 192kHz are 
accepted. In addition, the TXS25-4 evaluation board is 
capable of driving up to 4-Channels of post-processed 24-bit 
PCM data on jumper J7 (see Table 6). MCLKT = 256Fs. 
SCLKT = 64Fs. LRCKT = Fs. Fs for data on SDOUT0 and 
SDOUT1 is fixed at 48kHz regardless of audio input Fs.

 

Advanced Configuration with D2Audio 
Canvas II Software
All amplifier settings can be changed through the 2-wire 
control interface within the amplifier design. The D2Audio 
Canvas II software supplied with the evaluation kit provides 
a graphical interface and USB connection to a PC to adjust 
these settings on the evaluation kit. See the “D2Audio 
Canvas II Users Guide” for further details.

Hardware vs Software Configuration
The D2Audio Canvas II software can be used to configure 
the TXS25-4 to select between I2S/Left-Justified inputs 
SAI0, which is connected to an ADC on this evaluation kit vs 
I2S/Left-Justified SAI1 which is available for designers to 
wire-wrap in an external digital audio device to the amplifier 
design. SAI0 and SPDIFRX can be accepted by the amplifier 
design simultaneously. The user is responsible for 
configuring the routing/mixing/processing of these two audio 
inputs using the D2Audio Canvas II GUI. With only 2 
channels of audio physically connected to the board, this 
audio can be sent to all output channels using the Matrix 
Mixer and Routers, accessible through the D2Audio Canvas 
II software.

All settings, including master volume, are stored in an 
EEPROM within the amplifier design and are loaded upon 
reset or power-up. After power-up, the D2Audio Canvas II 
software can be used to change these settings and can 
update the EEPROM with a new set of defaults if desired. 
The only exception to this is the input selection settings 
which will always default back to the settings defined by the 
firmware.

Note the following:

Once the D2Audio Canvas II software is running, the Master 
Volume Control knob may still be used, however the Master 
Volume Control knob should not be adjusted when any 
D2Audio Canvas II hardware communication is taking place 
such as:

TABLE 4. J5 - I2S/LEFT-JUSTIFIED (SAI0) INPUT HEADER PINS

SIGNAL
FUNCTION

(I2S CHANNEL 0)

LRCLK0 3.3V Serial Audio Data Left/Right Frame 
Clock

SCLK0 3.3V Serial Audio Data Shift Clock 

SDIN0 3.3V Serial Audio Data

TABLE 5. J8 - I2S/LEFT-JUSTIFIED (SAI1) INPUT HEADER PINS

SIGNAL
FUNCTION

(I2S CHANNEL 1)

LRCLK1 3.3V Serial Audio Data Left/Right Frame 
Clock

SCLK1 3.3V Serial Audio Data Shift Clock 

SDIN1 3.3V Serial Audio Data
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FIGURE 17. OPTIONAL I2S/LEFT-JUSTIFIED CONNECTIONS

TABLE 6. J7 - I2S/LEFT-JUSTIFIED (SAO0, SAO1) OUTPUT 
HEADER PINS

FUNCTION 
SELECTION FUNCTION

SDOUT1 I2S Channel 1 - Serial Audio Data Output

SDOUT0 I2S Channel 0 - Serial Audio Data Output

LRCKT I2S Serial Audio Data Left/Right Frame Clock 
Output

SCLKT I2S Serial Audio Data Clock Output

MCLKT I2S Master Clock Output
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• Changing any D2Audio Canvas II controls including 
sliders, text fields, buttons, etc.

• Initial all-data transmit or receive performed during launch 
of D2Audio Canvas II and the associated “Connect to 
Module” process

• An all-data transmit or receive as triggered by the D2Audio 
Canvas II menu File->Transmit or File->Receive 
selections

• The D2Audio Canvas II menu Tools->Save Settings to 
EEPROM or Tools->Module Firmware Status selections

Alternatively, the designer can use the D2Audio Canvas II 
software to adjust the master volume, but just not at the 
same time as when the Master Volume Control knob is used.

Testing Methodology
The following sections detail the testing methodology for 
obtaining optimal test results using an Audio Precision 
System Two.

AES17 Filter Requirement
The test and measurement of a class-D audio amplifier 
requires additional considerations beyond that of a class-AB 
or class-A linear design. All Intersil amplifier products use 
noise-shaping techniques which provide extremely good 
noise and distortion performance within the audio band 

(20Hz to 20kHz) in exchange for increased out-of-band 
noise (>20kHz). Each amplifier design contains a low-pass 
audio output filter, which attenuates this out-of-band noise 
present in the amplified signal.

Despite the presence of this filter, a small amount of 
out-of-band noise is still present in the amplifier output. 
When a standard 8Ω speaker is connected to the amplifier, 
this out-of-band noise has no effect on performance. 
However, the high-frequency nature of the out-of-band noise 
can exceed the maximum slew rate of the Audio Precision 
analog inputs, which can create erroneous measurements. 
In order to properly interface the Audio Precision test 
equipment to a class-D audio amplifier, the AES17 filter 
option must be installed and enabled. The response of the 
AES17 20kHz filter is shown in Figure 18.

It is important to note that the AES17 filter does not artificially 
improve the test results of a class-D amplifier to make them 
appear similar to those of a traditional class-AB or class-A 
amplifier. The filter is only present to reduce the high slew 
rate content of the amplifier output so that the Audio 
Precision may perform a proper test.1

1.For further information, see the white paper
Measuring Switch-mode Power Amplifiers, by Bruce Hofer, Audio
Precision, 2003, available at www.audioprecision.com.

FIGURE 18. AES17 FILTER PASSBAND AND STOPBAND RESPONSE, WITH 20kHZ SETTING
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AUX-0025 Filter
In addition to the AES17 filter, Audio Precision has an 
AUX-0025 filter product for measuring class-D amplifiers that 
either have no output filter, or an output filter with a limited 
rolloff. However, the AUX-0025 filter is NOT necessary when 
testing Intersil products, as all Intersil amplifier designs 
contain an output filter with steep low-pass rolloff.

Testing Setup
For proper amplifier characterization, the following 
conditions should be met:

• Measurements should be taken with only one amplifier 
channel driven.

• An 8Ω resistive load should be used on the output of the 
channel under test, with the Audio Precision input 
connected in parallel and set for high impedance (100kΩ). 
Tests should not be run on a channel without an 8Ω load 
connected.

The software settings in the amplifier design should be set 
for “flat” response with 0dB of gain. Verify each of the 
following settings before proceeding with a test: (Refer to the 
D2Audio Canvas II operation manual for setting “flat 
response”).

• The master volume of the amplifier must be set to 0dB.

• Each individual channel volume of the amplifier must be 
set to -6dB. 

• All Equalizers, Tone Controls, Compression and 
Adjustable Time Delay should set to flat (0dB) or disabled.

Either analog or digital inputs may be used for testing. 
However, it is recommended that digital input sources (either 
I2S, Left-Justified or S/PDIF) be used for testing, as this will 
result in the most accurate measurement. 

TXS25-4 EVALUATION BOARD OUTPUT POWER NOTES
The TXS25-4 is a reference and evaluation board, and 
therefore does not include heatsinking capability for 
extended high power use. Its heatsinking, simply through the 
copper pads on the pc board, was designed for a maximum 
of 1/8th continuous power on all channels in an open-air 
ambient of +25°C. Do not run high power sine waves 
continuously unless you have added additional heatsinking 
to the TXS25-4, as without additional heatsinking capability 
for output devices, generate excessive heat will be 
generated.

TESTING WITH DIGITAL INPUTS (RECOMMENDED 
SETUP)
All Intersil amplifier designs are digital by nature, and 
therefore will perform best when used with a digital input 
source. For proper test results, 24-bits of resolution or more 
are required. For this reason, a CD player cannot be used as 
a digital source, as it only provides 16-bit resolution. 

When using the digital outputs of the Audio Precision, the 
following settings should be made:

• The TXS25-4 amplifier must be configured for the 
appropriate digital input (see “Input Source Options” on 
page 17)

• Data resolution should be 24 bits in the AP Digital 
Generator

• Pre-emphasis should be off in the AP Digital Generator

• Volts/FS reference should be set to 1V

Either S/PDIF or I2S/Left-Justified interfaces can be used. 
Specific settings for each interface are provided in the 
following:

S/PDIF Source Setup
In addition to the general digital configuration above, the 
following settings should be made in order to use the Audio 
Precision S/PDIF output:

• Either the optical or BNC electrical output can be used 
from the Audio Precision. Select the appropriate output in 

FIGURE 19. AUDIO PRECISION AES17 20kHZ FILTER 
SELECTION
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the Digital I/O panel. Also select the appropriate position 
for the S/PDIF Input Select Jumper on the TXS25-4 board.

• Set the sample rate to 48kHz in the Digital I/O panel 
(though any values from 32kHz to 192kHz are 
acceptable).

• Set the output voltage to 5VP-P in the Digital I/O panel

I2S Source Setup
The I2S/Left-Justified inputs on the TXS25-4 board can be 
connected to the output of an Audio Precision PSIA:

• Select the “PSIA” output in the Digital I/O panel.

• Select 3.3V CMOS as the output logic level in the PSIA 
Transmitter panel.

• Press the “I2S” button in the PSIA Transmitter panel to 
format the data for I2S.

• Press the “Outputs ON” button in the PSIA Transmitter 
panel to enable the PSIA output. Note that this button 
must be on in addition to the “Outputs ON” button in the 
Digital Generator panel in order for the PSIA output to 
function.

FIGURE 20. AUDIO PRECISION S/PDIF OUTPUT 
CONFIGURATION
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TESTING WITH ANALOG INPUTS
Analog-to-digital converters are present on the TXS25-4 
amplifier design. These can provide a secondary input 
source to the amplifier design. However, it is suggested that 
digital inputs be used for testing if at all possible, since 
analog input performance will be slightly less than that 
measured with the digital input. 

When using the analog outputs of the Audio Precision, the 
following settings should be made:

• The dBr Reference Voltage should be set to 2V in the 
Analog Generator Panel if using the analog inputs of the 
amplifier design.

• The dBr Reference Voltage should be set to 1V in the 
Analog Generator Panel if using the external 
high-performance ADCs.

• The Watts reference should be set to 8Ω in the Analog 
Generator Panel

• Z-Out should be set to 20Ω in the Analog Generator 
Panel.

• Configuration should be set for Unbal-Float in the Analog 
Generator Panel. Unbal-GND may yield better results.

FIGURE 21. AUDIO PRECISION I2S OUTPUT CONFIGURATION
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Typical Basic Measurements
The following measurements in Table 7 can be made by 
using the Analog Analyzer panels in the Audio Precision 
software. The measurements in Table 8 were made using a 
digital input source.   

TXS25-4 Evaluation Platform Hardware
Power Supplies
The TXS25-4 amplifier design operates from a single +25V, 
5A DC power supply. This external power supply connects to 
header J28 of the amplifier output board, where DC power 
filtering is also provided. All other operating voltages are 
internally generated from this 25V source. The TXS25-4 
amplifier board internally generates -25V for the FETs. (This 
is a half-bridge design.) The first switching stage takes the 
+25V primary input supply voltage and generates the 
required -25V, under the control of the D2-814xx IC. The 
+25V is also sent to a DC/DC circuit which regulates down to 
+5V; the second stage regulates +5V down to +3.3V and 
+1.8V for the control input functions using parallel linear 
regulators. The low voltage regulation provides proper power 
sequencing in addition to low power dissipation (high 
efficiency). 

Remote Input Board
The TXS25-4 evaluation PCB allows the Digital/Analog 
Audio/Control I/O Board and Amplifier Output sections of the 
board to be separated from the TXS25-4 amplifier board. 
The ribbon cables may be extended by replacing the 
provided ribbon cables. This allows the Digital/Analog 
Audio/Control I/O Board section to be mounted remotely 
from the TXS25-4 and output boards as well as allowing for 
easier design-in for prototyping. Extension of the ribbon 
cable may result in degradation of the digital audio input 
signal (I2S/LJ (from headers or 4-Channel ADC) or S/PDIF) 
signal integrity. Extension should be limited to six inches or 
less.TABLE 7. TXS25-4 BASIC MEASUREMENTS, RATED 

POWER, 8Ω LOAD (-0.5DBFS INPUT)

MEASUREMENT DESCRIPTION
TYPICAL 
RESULT UNITS

Output voltage on speaker terminals 31 VRMS

Total Harmonic Distortion + Noise Percentage 
(THD+N) 20Hz to 20kHz

<0.2 %

Signal to Noise+Distortion Ratio (Total Harmonic 
Distortion + Noise Amplitude relative to full scale 
output (31VRMS))

>-105 dBr

NOTE:
1. These results are preliminary, based on Rev 1 of the TXS25-4 

Evaluation Kit.

TABLE 8. TXS25-4 BASIC MEASUREMENTS, 1W POWER, 8Ω 
LOAD (-21DBFS INPUT) @ 1kHz

MEASUREMENT DESCRIPTION
TYPICAL 
RESULT UNITS

Output voltage on speaker terminals 2.8 VRMS

Total Harmonic Distortion + Noise Percentage 
(THD+N) 20Hz to 20kHz

<.05 %

NOTE:
2. These results are preliminary, based on Rev 1 of the TXS25-4 

Evaluation Kit.

FIGURE 22. AUDIO PRECISION ANALOG OUTPUT 
CONFIGURATION
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USB Interface
A USB interface is provided on the TXS25-4 evaluation 
platform to provide communications between the TXS25-4 
amplifier design and an external PC based system. The USB 
interface provides a means of upgrading the amplifier design 
system parameters, input sources, and DSP firmware. The 
D2Audio Canvas II utility provided with the TXS25-4 
evaluation platform utilizes this interface. Refer to the 
D2Audio Canvas II Users Guide for USB driver installation 
and instructions.

DETACHED TXS25-4
AMPLIFIER BOARD

DETACHED DIGITAL/ANALOG AUDIO/
CONTROL I/O BOARD

RIBBON CABLE

DETACHED AMPLIFIER
OUTPUT BOARD

RIBBON CABLE

FIGURE 23. DIGITAL/ANALOG AUDIO/CONTROL I/O BOARD, AMPLIFIER BOARD, AND OUTPUT BOARD
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nPWM_ERR4

+3.3V+5V

SYNC_2670

+1.8V

+1.8V

+3.3V

+1.8V

+3.3V

+1.8V

+3.3V

OSCGND

+1
.8

V

+1.8V

+3.3V

+3.3V

+3
.3

V

+1
.8

V

OSCGND

+1
.8

V

+3
.3

V

+3.3V

+3.3V

+1
.8

V

+3.3V

+1.8V

+3
.3

V

+3.3V

+5V

+3.3V

+5V

+1.8V

+5V

+3.3V+3.3V+3.3V+3.3V

+3.3V

+1.8V

0 1 1 1

0

D2-81412-LR Boot Modes

2-wire ROM on GPIO6,7

2-wire slave, addr = 1000 100x 11 1 0 0

1

nBOOT_EEBOOT_EE/I2CIRQ [D:A]

0

Boot Source

Optional
Tantalum

(same footprint)

Optional
Tantalum

(same footprint)

Optional
Tantalum

(same footprint)

MMBT2222

E

C

B

Rail Over-Voltag

GPIO0 = I2C Address Select
GPIO1 = Standby/Sleep

Optional

Local Power Supplies

Operating Mode Configuration

Stuff Bulks If No Local Reg's

C21
0.1uF
0603

C21
0.1uF
0603

R6
1M
0603

R6
1M
0603

C22
0.1uF
0603

C22
0.1uF
0603

C1

0.1uF
0603

C1

0.1uF
0603

R198
NS
0603

R198
NS
0603

C36
0.1uF
0603

C36
0.1uF
0603

Y1
24.576MHZ
Y1
24.576MHZ

R72

33.2
0603

R72

33.2
0603

C17
18pF
0603

C17
18pF
0603

D1
EP05Q04

D1
EP05Q04

2
1

R25
1K
0603

R25
1K
0603

C83
0.1uF
0603

C83
0.1uF
0603

R81

33.2
0603

R81

33.2
0603

R24

33.2
0603

R24

33.2
0603

R9

10K
0603

R9

10K
0603

C11

0.1uF
0603

C11

0.1uF
0603

R33

1K
0603

R33

1K
0603

+ C4
100uF
6.3V

+ C4
100uF
6.3V

R27
10K
0603

R27
10K
0603

D2

EP05Q04

D2

EP05Q04

2 1

+ C6
100uF
6.3V

+ C6
100uF
6.3V

C40

0.1uF
0603

C40

0.1uF
0603

R26
10K
0603

R26
10K
0603

R78
33.20603
R78
33.20603

R193
10K
0603

R193
10K
0603

R19
10K
0603

R19
10K
0603

+C26
22uF

6.3VDC

+C26
22uF

6.3VDC

R23

33.2
0603

R23

33.2
0603

C13
0.1uF
0603

C13
0.1uF
0603

C28
0.1uF
0603

C28
0.1uF
0603

R32
4.75K
0603

R32
4.75K
0603

R82

33.2
0603

R82

33.2
0603

C34
0.1uF
0603

C34
0.1uF
0603

C31
0.1uF
0603

C31
0.1uF
0603

C7
0.1uF
0603

C7
0.1uF
0603

R14
10K
0603

R14
10K
0603

C47

0.1uF
0603

C47

0.1uF
0603

Y2
NS
Y2
NS

J2

HDR 15X2

 T
SW

-1
15

-0
6-

T-
D

-L
L

J2

HDR 15X2

 T
SW

-1
15

-0
6-

T-
D

-L
L

2
4
6
8
10
12
14
16
18
20
22
24
26
28
30

1
3
5
7
9

11
13
15
17
19
21
23
25
27
29

R196
10K
0603

R196
10K
0603

C45
0.1uF
0603

C45
0.1uF
0603

C9
0.1uF
0603

C9
0.1uF
0603

R16
10K
0603

R16
10K
0603

U3

D2-81412-LR
U3

D2-81412-LR

SPDIFTX1
SPDIFRX2
TXD3
RXD4
SCLK5
RVDD6

SCKR08
SDIN09
LRCKR010
CVDD11
CGND12
SCKR113
SDIN114
LRCKR115
MCLK16
SCKT17
SDO18
LRCLKT19
STD020
SCK021
SRD022
SC0023
SC0124
SC0225
GPIO026

CGND28 CVDD27

GPIO129
RVDD30
RGND31
GPIO232
GPIO333
GPIO434
GPIO535
GPIO636

RGND7

G
P

IO
7

37
X

G
P

IO
15

38
X

G
P

IO
14

39
X

G
P

IO
10

40
X

G
P

IO
9

41
X

G
P

IO
8

42
X

G
P

IO
7

43
C

V
D

D
44

C
G

N
D

45
X

G
P

IO
6

46
R

V
D

D
47

R
G

N
D

48
X

G
P

IO
5

49
X

G
P

IO
4

50
X

G
P

IO
3

51
X

G
P

IO
2

52
X

G
P

IO
1

53
X

G
P

IO
0

54
X

G
P

IO
12

55
X

G
P

IO
11

56
X

G
P

IO
13

57
TE

S
T

58
C

V
D

D
59

C
G

N
D

60
B

M
S

0
61

B
M

S
1

62
R

V
D

D
63

R
G

N
D

64
B

M
S

2
65

B
M

S
3

66
C

TR
L0

67
C

TR
L1

68
C

TR
L2

69
N

C
70

N
C

71
C

TR
L3

72

N/C 73OTSEL 74PROTECTC3 75PROTECTB3 76PROTECTA3 77PROTECTC2 78PROTECTB2 79PROTECTA2 80CVDD 81CGND 82RVDD 83RGND 84PROTECTC1 85PROTECTB1 86PROTECTA1 87PROTECTC0 88PROTECTB0 89PROTECTA0 90CVDD 91CGND 92PWMGND 93PWML3 94PWMH3 95PWMVDD 96PWMGND 97PWML2 98PWMH2 99PWMVDD 100PWMGND 101PWML1 102PWMH1 103PWMVDD 104PWMGND 105PWML0 106PWMH0 107PWMVDD 108O
S

C
O

U
T

10
9

P
LL

G
N

D
11

0
P

LL
V

D
D

11
1

N
C

11
2

N
C

11
3

O
S

C
V

D
D

11
4

X
TA

LI
11

5
X

TA
LO

11
6

O
S

C
G

N
D

11
7

P
LL

A
G

N
D

11
8

P
LL

A
V

D
D

11
9

nT
R

S
T

12
0

S
Y

S
1

12
1

C
V

D
D

12
2

C
G

N
D

12
3

S
Y

S
0

12
4

S
Y

S
2

12
5

S
Y

S
4

12
6

S
Y

S
3

12
7

R
V

D
D

12
8

R
G

N
D

12
9

S
C

12
13

0
S

C
11

13
1

S
C

10
13

2
S

TD
1

13
3

S
C

K
1

13
4

S
R

D
1

13
5

C
V

D
D

13
6

C
G

N
D

13
7

nR
S

TO
U

T
13

8
nR

E
S

E
T

13
9

TI
O

0
14

0
TI

O
1

14
1

TI
O

2
14

2
S

D
A

14
3

S
C

L
14

4

R35
10K
0603

R35
10K
0603

R36

10K
0603

R36

10K
0603

R7
33.2
0603

R7
33.2
0603

+ C5
100uF
6.3V

+ C5
100uF
6.3V

VIN
VOUT
TAB

GND
U7

LM1117MPX-1.8V

VIN
VOUT
TAB

GND
U7

LM1117MPX-1.8V
3 4

2

1

C12

0.1uF
0603

C12

0.1uF
0603

R74
10K
0603

R74
10K
0603

R197
NS
0603

R197
NS
0603

R195
10K
0603

R195
10K
0603

R22

0-Ohm
0805

R22

0-Ohm
0805

R20
10K
0603

R20
10K
0603

R11
10K
0603

R11
10K
0603

R77
33.20603
R77
33.20603

R34
162
0603

R34
162
0603

L1

600-Ohm@100MHz

0805

L1

600-Ohm@100MHz

0805

R12
10K
0603

R12
10K
0603

+ C33
NS
6.3VDC

+ C33
NS
6.3VDC

R80
33.20603
R80
33.20603

LED2

GRN LED
LED0603

LED2

GRN LED
LED0603

21

+ C15
NS
6.3VDC

+ C15
NS
6.3VDC

R28
10K
0603

R28
10K
0603

LED1

RED LED
LED0603

LED1

RED LED
LED0603

21

U2

AT24C512

U2

AT24C512

A01
A12
A23
GND4

VCC 8
WP 7
SCL 6
SDA 5

R15
10K
0603

R15
10K
0603

R21
10K
0603

R21
10K
0603

Q3
MMBT2222A
SOT-23

Q3
MMBT2222A
SOT-23

R73
10K
0603

R73
10K
0603

C3

0.1uF
0603

C3

0.1uF
0603

+ C196
NS
6.3V

+ C196
NS
6.3V

R75
10K
0603

R75
10K
0603

C8
0.1uF
0603

C8
0.1uF
0603

R199
NS
0603

R199
NS
0603

VIN
VOUT
TAB

GND
U6

LM1117MPX-3.3V

VIN
VOUT
TAB

GND
U6

LM1117MPX-3.3V
3 4

2

1

C25
0.1uF
0603

C25
0.1uF
0603

+ C198
NS
6.3V

+ C198
NS
6.3V

C20
0.1uF
0603

C20
0.1uF
0603

C18
18pF
0603

C18
18pF
0603

R17
10K
0603

R17
10K
0603

+ C14
22uF
6.3VDC

+ C14
22uF
6.3VDC

R13
10K
0603

R13
10K
0603

R200
NS
0603

R200
NS
0603

C39
0.1uF
0603

C39
0.1uF
0603

C43

0.1uF
0603

C43

0.1uF
0603

R86

33.2
0603

R86

33.2
0603

C38
0.1uF
0603

C38
0.1uF
0603

C197
0.1uF
0603

C197
0.1uF
0603

R194
10K
0603

R194
10K
0603

+C32
22uF

6.3VDC

+C32
22uF

6.3VDC

R79
33.20603
R79
33.20603

C84
0.1uF
0603

C84
0.1uF
0603

R76
10K
0603

R76
10K
0603

C199
0.1uF
0603

C199
0.1uF
0603

C44

0.1uF
0603

C44

0.1uF
0603

Q4
MMBT2222A
SOT-23

Q4
MMBT2222A
SOT-23

Q1
MMBT2222A

SOT-23

Q1
MMBT2222A

SOT-23

C46

0.1uF
0603

C46

0.1uF
0603

D16
BZX84C39

SOT-23
+39V

D16
BZX84C39

SOT-23
+39V

1 2

3

C16

0.1uF
0603

C16

0.1uF
0603

D4
EP05Q04

D4
EP05Q04

C2

0.1uF
0603

C2

0.1uF
0603

R18
10K
0603

R18
10K
0603

+ C27
NS
6.3VDC

+ C27
NS
6.3VDC
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5

5

4

4

3

3

2

2

D

C

B

A

DRAIN2

DRAIN1

+5V

+25V

-25V

+3.3V

OUT1+

OUT2-

PWM1H

nPWM_E

PWM2H

nPWM_E

PWM2L

PWM1L

+3.3V

+3.3V

PWR_GND

PWR_GND

PWR_GND

+5V

+3.3V

-25V

+25V
+25V

+25V

-25V

-25V

+5V +5V

-25V

OUT1+

OUT2-

+5V

+3.3V

+25V

Kelvin Connections

Kelvin Connections
C52

0.68uF
X7R
50V

C52
0.68uF

X7R
50V

R70

0-Ohm
0805

R70

0-Ohm
0805

R58
10K
0603

R58
10K
0603

Q11
FMMT493A
SOT-23

Q11
FMMT493A
SOT-23

Q5
ZXMP6A17G
SOT-223

Q5
ZXMP6A17G
SOT-223

1

3
2 4

C80
0.1uF
0603

C80
0.1uF
0603

C81
0.1uF
0603

C81
0.1uF
0603

C56
2200pF
0805

C56
2200pF
0805

R56

0.15
1210

R56

0.15
1210

R66
681
0603

R66
681
0603

C73
2200pF
0805

C73
2200pF
0805

R47
1K
0603

R47
1K
0603

R55
10K
0603

R55
10K
0603

U3C
74VHC125

U3C
74VHC125

9 8

10

U4A

74VHC04

U4A

74VHC04

1 2

C74

0.1uF
0805

C74

0.1uF
0805

C70
0.033uF

50VDC
X7R

C70
0.033uF

50VDC
X7R

C69
0.68uF

X7R
50V

C69
0.68uF

X7R
50V

R39
10K
0603

R39
10K
0603

C60
100pF

0603

C60
100pF

0603

Q8
ZXMN6A11G
SOT-223

Q8
ZXMN6A11G
SOT-2231

2
3

4

R42

0.15
1210

R42

0.15
1210

R48
820

0603

R48
820

0603

D10
EP05Q04

D10
EP05Q04

2
1

R65

2K
0603

R65

2K
0603

U4F

74VHC04

U4F

74VHC04

9 8

C72
0.1uF
0805

C72
0.1uF
0805

Q14
FMMT593-PNP

SOT-23

Q14
FMMT593-PNP

SOT-23

U3B

74VHC125

U3B

74VHC125

5 6

4

C54
.47uF

Film
50 VDC

C54
.47uF

Film
50 VDC

C67

0.1uF
0805

C67

0.1uF
0805

Q16
FMMT493A
SOT-23

Q16
FMMT493A
SOT-23

R71

0-ohm
0805

R71

0-ohm
0805

R68

0-Ohm
0805

R68

0-Ohm
0805

C59
100pF
0603

C59
100pF
0603

R50
4.99K
0603

R50
4.99K
0603

Q12
ZXMP6A17G
SOT-223

Q12
ZXMP6A17G
SOT-223

1

3
2 4

U4B

74VHC04

U4B

74VHC04

3 4

C48
1uF
0805

C48
1uF
0805

C64
1uF
0805

C64
1uF
0805

C50

0.1uF
0805

C50

0.1uF
0805

D9
EP05Q04
D9
EP05Q04

2
1

U3D
74VHC125

U3D
74VHC125

12 11

13

C76
100pF
0603

C76
100pF
0603

L3

33uH
DO3340P-333

L3

33uH
DO3340P-333

R60
1K
0603

R60
1K
0603

D13
EP05Q04

D13
EP05Q04

2
1

Q10
FMMT593-PNP

SOT-23

Q10
FMMT593-PNP

SOT-23

C53
0.033uF

50VDC
X7R

C53
0.033uF

50VDC
X7R

R59

100
0603

R59

100
0603

U4C

74VHC04

U4C

74VHC04

5 6

R45
10K
0603

R45
10K
0603

R62
820
0603

R62
820
0603

U3E
74VHC125

U3E
74VHC125

14
7

Q13
ZXMN6A11G
SOT-223

Q13
ZXMN6A11G
SOT-2231

2
3

4

C61
100pF
0603

C61
100pF
0603

C79

.47uF
1206
X7R

C79

.47uF
1206
X7R

R51

100
0603

R51

100
0603

C77
100pF

0603

C77
100pF

0603
R63

4.99K
0603

R63
4.99K
0603

D14
EP05Q04
D14
EP05Q04

2
1

C71
.47uF

Film
50 VDC

C71
.47uF

Film
50 VDC

R49
820
0603

R49
820
0603

C55
0.1uF
0805

C55
0.1uF
0805

U4E

74VHC04

U4E

74VHC04

11 10

L4

33uH
DO3340P-333

L4

33uH
DO3340P-333

D5
EP05Q04

D5
EP05Q04

2
1

C57

0.1uF
0805

C57

0.1uF
0805

R61
820

0603

R61
820

0603

R64

100
0603

R64

100
0603

R52

2K
0603

R52

2K
0603

R53
681
0603

R53
681
0603

U4D

74VHC04

U4D

74VHC04

13 12

U4G

74VHC04

U4G

74VHC04

7
14

C78
100pF
0603

C78
100pF
0603

Q9
FMMT593-PNP

SOT-23

Q9
FMMT593-PNP

SOT-23

R46

100
0603

R46

100
0603

R69

0-Ohm
0805

R69

0-Ohm
0805

Q15
FMMT593-PNP

SOT-23

Q15
FMMT593-PNP

SOT-23

U3A
74VHC125

U3A
74VHC125

2 3

1

C49

.47uF
1206
X7R

C49

.47uF
1206
X7R

D8
EP05Q04

D8
EP05Q04

2
1
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5

5

4

4

3

3

2

2

D

C

B

A

DRAIN4

DRAIN3 OUT3+

OUT4-

+25V

-25V

+3.3V

+5V

+3.3V

PWM3H

nPWM_ER

+3.3V

PWM4H

nPWM_ER

PWM4L

PWM3L

+3.3V

+3.3V

PWR_GND

PWR_GND

PWR_GND

+25V

+25V

-25V

-25V

+3.3V

-25V

+25V

+5V +5V

+5V

OUT3+

OUT4-

-25V

+3.3V

+25V

+5V

Kelvin Connections

Kelvin Connections

U9D
74VHC125

U9D
74VHC125

12 11

13

D18
EP05Q04

D18
EP05Q04

2
1

R107
820

0603
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Revisions
02/6/06         Revision 0.0.1 - First Internal Release.

Leveraged existing TXS25-2 evaluation document and 
updated with basic TXS25-4 information including signal 
flow, connection diagrams, jumper configurations, 
schematics, and images.

02/14/06         Revision 0.0.2 - Second Internal Release.

• Moved Master Volume in “ Required Power Source” 

• Updated 8/4 ohm text and ground referencing text on 
page 7

• Updated “TABLE 3.  DEFAULT DIGITAL/ANALOG 
AUDIO/CONTROL I/O BOARD FACTORY JUMPER 
SELECTION” values

• Added continuous sine wave note in See “Testing Setup” 
on page 21.

• Added 32-192kHz range in See “Testing with Digital Inputs 
(Recommended Setup)” on page 21. and See “Testing 
with Analog Inputs” on page 23.

• Updated full scale output text in Table 7 on page 24

Replaced mentions of “module” with “amplifier design”

02/15/06         Revision 1.0.0 - First Public Release.

• Updated verbiage on page 7 to improve clarity.

• Updated “ ” 

• Updated verbiage and added additional graphics to page 
16 in order to describe exactly how to select an analog 
input, S/PDIF input or I2S/Left-Justified input.

09/30/08         Revision 1.0.2 (revision 1.0.1 not released)

• Updated Intersil and D2Audio name references.

• Updated and revised photos to better represent platform

• Added updates to power supply references.

• Rewording and text additions throughout for clarity.

• Update to signal flow diagram to include D2Audio 
SoundSuite

10/14/08 Revision 1.0.3 (revision 1.0.1 not released)

• Conversion from book file to Frame

D2™, D2A™, D2Audio™, D2Audio 360°Sound™, D2Audio AccuMatrix™, D2Audio Acoustical Speaker Detect™, D2Audio AFRC 
(Automatic Frequency Response Compensation)™, D2Audio ARMC (Automatic Room Mode Correction)™, D2Audio Audio 
Canvas™, D2Audio AudioAlign™, D2Audio Canvas™, D2Audio Canvas 2.0™, D2Audio Canvas II™, D2Audio ClearVoice™, 
D2Audio DeepBass™, D2Audio DigitalEQ™, D2Audio Electrical Speaker Detect™, D2Audio HILO™, D2Audio LEO (Listenting 
Environment Optimization)™, D2Audio LEOxpc™, D2Audio Load Monitor™, D2Audio Mono2Stereo™, D2Audio Multi-Crossover 
Digital Bass Management™, D2Audio MultiMix™, D2Audio Multi-Mix™, D2Audio Page-In™, D2Audio Sound Pressure 
Normalization™, D2Audio SoundSuite™, D2Audio Speaker Detect™, D2Audio Speaker Distance™, D2Audio Speaker EQ 
(SPEQ)™, D2Audio Speaker Fingerprint™, D2Audio Speaker Impedance™, D2Audio Speaker Polarity™, D2Audio WideSound™, 
Digital Audio Engine™ and DAE-3™ are trademarks of D2Audio Corporation.

Audistry™ by Dolby,  Dolby Headphone™, Dolby Pro Logic II, Dolby Pro Logic II/IIx™, Dolby Pro Logic II™, Dolby Virtual 
Speaker™, and Surround EX™ are trademarks of Dolby Laboratories Licensing Corporation. Audyssey 2EQ™, Audyssey EQ™, 
Audyssey MultEQ Pro™, Audyssey MultEQ XT™ and Audyssey MultEQ™ are trademarkss of Audyssey Laboratories, Inc. BBE™ 
is a trademark of BBE Sound, Inc. DTS Neo:6™ is a trademark of Digital Theater Systems, Inc. Logic 7™ is a trademark of 
Harman International Industries, Incorporated. Microsoft™, Windows™ XP, Windows™ 2000 are trademarks of Microsoft 
Corporation. SRS Definition™, SRS Dialog Clarity™, SRS FOCUS™, SRS Headphone 360™, SRS TruBass™, SRS TruSurround 
HD™, SRS TruSurround HD4™, SRS TruSurround XT HD/HD4™, SRS TruSurround XT™, SRS TruSurround™, SRS WOW 
HD™ and SRS WOW™ are trademarks of SRS Labratories, Inc. THX Adaptive De-Correlation™, THX Advanced Speaker Array 
(ASA)™, THX Bass Management with Bass Peak Limiter™, THX Boundary Gain Compensation (BGC)™, THX Cinema Re-EQ™, 
THX™ Ultra2™ and THX™ Select™ are trademarks of  THX Ltd.
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